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WHERE TO BEGIN

What do you hope to learn from this class?

What types of documents do you need or would
you like to create!

Have you used any other versions
before or a similar program!?

What version of Word do

What |/you need to
ou have? Work/home

know before we start




1D YOU KNOW

Avg. person spends 255 hours/yr futzing around on computer —3X
more than the typical American gets in vacation time each year!

Futzing? "time spent solving the little, mundane problems that occur
as we struggle to master our machines."

Est. that this costs U.S. economy about $350 billion/yr in lost
GDP, more than 3X what U.S. spent on education in 2015!

Men are 19% more likely to waste time futzing than women.Why?
Because women typically just ask for help.




@ PowerPaint 2013
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Documents
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. Spotify
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% fune
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Search for online templates Jo Patty Ball
O r pksun2d@comcast.net

Suggested searches: Letters Resume Fax Labels (Cards Calendar Blank Switch account

Recent

NECC payroll sept octdocx 9 Aa Title =]

My Documents = Personal

Microsoft Word course agenda.docx
F: » Word 2010 Class

Pball Resume 2014.docx Take a
My Documents = Personal
tour

Blank document Welcome to Word Single spaced (blank) Blog post

MNAP library research.docx

E: » Education » Research

Getting to know email.docx
E: » Presentations » NSCC courses » Qutlook

email etiquette.docx

E: » Presentations » NSCC courses » Qutlook T|‘|‘| e T]tle T |'t I o

Patty Ball final presentation sloan rem... Heading Heading 1 HEADING
My Documents = Personal

Mouth Watering Super Chocolate Mu... |
My Documents » Recipes

income 2014 from state.docx B

My Documents = Personal . . ... . . ... . .. ...

Constant Contact.docx
G: » Patty » Resumes and evals Ion design (blank) Facet design (blank) Report design (blank) Resume

bitly box net URLdoc
E: » Word 2010 Class

PowerPoint description.docx JOIN US AT OUR

My Documents = Personal ANNUAL EVENT
= EVENT SCHEDULE PLANHER [YEAR]
Replay Registration Code Information... T | WANT TO VOLUNTEER
My Documents » Personal E———
== =

E Open Other Documents T T




~ woro) FROM THE FILE TAB

Info

»

Protect
Document -

95

Issues =

Office Tab

Account a

Manage
Versions ~

Options

Protect Document

Control what types of changes people can make to this document.

Inspect Document

Before publishing this file, be aware that it contains:
Document properties, content type information, template name and author's
name
Headers
Custom XML data
A setting that automatically removes properties and personal information when
the file is saved
Allow this information to be saved in your file

Versions

] There are no previous versions of this file.




Create your first Word 2013 document Closed captions B3

™o

ST
ocument

Press F5 to start, Esc to stop 1/5 videos

Word 3085/9.0 et @ Y @ :
: 3:03 3:05 | 2:58 |

Get started Save and print Add formatting Insert things Headers Summary Feedback Help




THE RIBBON

I Tabs I
Random Text.docx - Word 0 | 8 X
REVEW  VIEW  OFFICE TAB Patty Bpll 'l
# Find

PAGELAYOUT  REFERENCES  MAILINGS
=vi=viicy [ EEE|BS A R Al
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vac

H
X AW A EBE== 12, Bl )N | | | ‘ ' ' w (2] N
A A S Qe lormal | TNoSpac.. Headingl Heading2  Title Subtitle  SubtleEm.. Emphasis IntenseE.. |5 1 Select~
Styles v Editing A

¥ Format Painter
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Clipboard ¥ f Paragraph

Groups




File I Home Insert Page Layout Feferences Mailings Review View

.'.'- ‘E Calibri (Body) ~ 11 ~ A" a7 | Aa~ N2, = =2 | T || 1 aasbo laat
= .

Pafte F B J U -abe x, x* [~ 87 AR 3 fv@v_* T Asdfasdf | Th

Clipboard Font

L

Click on a tab
to see more
commands.

Clickon a Each tab will Some groups will have

an arrow that you can

have one or
more groups.

command to

do something. click for more options.




RIBBON — SHOW/HIDE

[ ------ Auto-hide Ribbon
1‘ Hide the Ribbon. Click at the top

of the application to show it.

F Show Tabs
Show Ribbon tabs only. Click a

tab to show the commands.

— Show Tabs and Commands

=== | Chew Ribbon tabs and h
commands all the time.




HOME TAB

m H © O ¢V = New Document - Word DRAWING TOOLS
HOME INSERT DESIGN PAGE LAYOUT REFERENCES MAILINGS REVIEW VIEW FORMAT
- - - o — L — § — e . Find ~
sibriBody) ~[11_ | A A" Aav B0 Z-iE-F- &8 8T | aaepcend] asbcede AaBbCc ol T
g : 23c Replace
Pa'ste ¢ B I U-aex,x A-¥-A- E=EEH== - O-H- RNomal § INoSpec.. Headingl v [y Select -
Clipboard & Font r Paragraph I Styles M Editing

The Home tab gives you access to some of the most commonly used commands for working with Word
2013, including copying and pasting, formatting, aligning paragraphs, and choosing document styles.
The Home tab is selected by default whenever you open Word.




GLIPBOARD

(]| 9 - G [T —

W Insert Page Layout

i g -
‘ Calibri (Body) - 11 ~ A A~

-~

Paste ? B /7 U - — X, ** 2\

- [P’
Clipboard Font
(]| | copy (cti+Q
Copy the selection and put it on
H the Clipboard.
o |

< Construction/Remodel: 520,000
% Computers: 525,000

< Communication: 3900
affealamiamant: $12,000

Keep Source Formatting (K}

(][ G 9 - [ —
W Insert Page Layout
i i
é Calibri (Body)] ~ 11 = A a7

Paste B 7 U - ahe x, X° /e
# u

[Fa
w

Clipboard ra Font

[L] Cut (Ctri+X)

Cut the selection and put it on the

H Clipboard.
= E |

As the popularity of the Internet continues to grow,
affordable access is becoming a necessity. WebDen
provides people with the ability to access the
Internet in a social environment. People of all ages
and backgrounds are welcome to enjoy the quirky,
upscale, and innovative environment that only
WebDen provides. Coffee, entertainment, and the
Internet together form an engaging social scene. i

i




HAT IS IN THE Fo

Shrink Font

Hﬂme\lQiH Page |-\Q\ kerencef Mailings
Cambria -~ 11 |A A ||i/
S
Paste 2 ||B I U - abe x, x Aa-|¥ - A ||
=

Font Colour  Font Dialog Launcher

Font Size Grow Font

.|_ -

=

ipboard ™~ Font




. FORMAT TEKT

Release mouse

- highlighted

box appears

over selected
text.




Video provides a powerful way to help you prove your point. When you click Online Video, you can
paste in the embed code for the video you want to add. You can also type a keyword to search
online for the video that best fits your document. To make your document look professionally
produced, Word provides header, footer, cover page, and text box designs that complement each
other. For example, you can add a matching cover page, header, and sidebar.

Click Insert and then choose the elements you want from the different galleries. Themes and styles
also help keep your document coordinated. When you click Design and choose a new Theme, the

pictures, charts, and SmartArt graphics change to match your new theme. When you apply styles,
your headings change to match the new theme. Save time in Word with new buttons that show up

wh~ra you need them.

1charge nevey 1 pztare bz inyour foco.mnt. i kitene a b ttor for lay wu optir s ppears
next to 1t. When you work on 11 ble, click where you want to add a row or a column, and then click
the plus sign. Reading is easier, too, in the new Reading view. You can collapse parts of the
document and focus on the text you want. If you need to stop reading before you reach the end,
Word remembers where you left off - even on another device.

Video provides a powerful way to help you prove your point. When you click Online Video, you can
paste in the embed code for the video you want to add. You can also type a keyword to search
online for the video that best fits your document. To make your document look professionally
produced, Word provides header, footer, cover page, and text box designs that complement each
other. For example, you can add a matching cover page, header, and sidebar.




* Reorganize WORKING

WITHTEXT
> E dit Clipboard
e Cut
* Copy

e Paste




FORMAT PAINTER

Paste — ™
( J Format Pamten

Clnpbnard f;.
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Paragraph o Bullets, Numbering,

Paragraph _ O Utl i n e

Indents and Spacing l Line and Page Breaks l Y AI 1
zeneral Ign ment
Alignment: Left - Outline level: Body text
= * |Indent
Indentation

. * Paragraph Spacing
Right: = linone) =] | | o Sor t
oo
por =

L]
Before: Opt x Line spacing: At: o FI I I

After: 0 pt = |5ingle j il
- * Borders

* Show/Hide
T b * Paragraph Dialog Box
* Tabs (later)

Spacdng

Tabs... QK | Cancel




BULLETS, LISTS NUMBERING

Farewell dinner preparation

1. Book venue (San Francisco Radix Gardens)

2

Contact vendors

Book San Diego Quintessential Quartet
Book Moment of Melody Children’s Choir
Send invitations

e e

w

Perpetua 16 ~ A AT A,.
° S
Day of the dinner , ; | a . A-:=-Il- sves

6. Approve locatioln sef 1n
7. :-\rrange seating:

8. Setup podium =
0

Paste Options:
e £ £

e
2 Lo LA
Adjust List Indents...

Restart at 1

: e
Y

Continue Numbering

'™

Set Numbering Value...
Font...

Paragraph...

© a >

Smart Lookup
Synonyms 4
Translate

Hyperlink...

U e s

New Comment




CONTEXTUAL TABS

§ =3 © O ¢ =+ New Document - Word DRAWING TOOLS

HOME  INSERT  DESIGN  PAGELAYOUT  REFERENCES  MAILINGS  REVIEW  VIEW FORMAT

[_T) <~ 2 - A.‘ A - || Text Direction ~ j @ ) Bring Forward ~ [¢ ~ 31
b = l A I ARC Abc ‘ N [_-L - J = U{; Send Backward ~ g1~
Q

(3] Align Text ~ ,
Quick ’ Position Wrap ) Size
¥ Styles~ [\~ @ CreateLink v Text~ Ok Selection Pane A~ v

Insert Shapes Shape Styles s WordArt Styles s Text Arrange

Contextual tabs will appear on the Ribbon when working with certain items, such as tables and pictures.
These tabs contain special command groups that can help you format these items as needed.




Useful contextual tab commands

Action
Select a picture style

Sharpen, soften or change the
brightness/contrast of a photo

Change the color saturation or tone of a photo,

or re-color it
Select a table style

Select a chart style

Weord 2013 Ribbon location
Picture Tools/Format tab --= Picture Styles group

Picture Tools/Format tab --> Adjust group --= Corrections

Picture Tools/Format tab --= Adjust group --= Color

Table Tools/Design tab --= Table Styles group

Chart Tools/Design tab --= Chart Styles group

Keyboard shortcut
Alt-JP. K

Alt-JP. R

Alt-JF. |

Alt-JT. 5

Alt-JC. 5




QUICK ACGESS TOOLBAR

e o i

FILE HOME Customize Quick Access Toolbar T

o ¥ - New = .
D Calibri (Bc =
oy || _ Open =
Paste B I L
. v = v Save Sy -
Clipboard Email
— L1 g Quick Print
k . Print Preview and Print
Insert Design Spelling & Grammar
v Undo
D Calibri (Body) ~'11 ~ A v Redo
Draw Table
Paste . B I U - abe x, X*
- Touch/Mouse Mode
Clipboard Font More Commands...

Show Below the Ribbon




MINI TOOLBAR

Increase Decrease
Font Size Font Size |HCFEESE

- Font Size n dent
Calibri ([Bot -~ 11  ~ A" A7 LéAT j | ‘ | aedcgﬁﬁse
= i _|

e Font r——
:: - CalibrifE~ 11 ~ A = =

I I
Some selected text Bold | I—I | |  Format

) Font Painter
Italic Color

Underline Center nghllght
Color




BACKSTAGE VIEW

Backstage view gives you various options for saving, opening a file, printing, and sharing your document.

To access Backstage view:

1. Click the File tab on the Ribbon. Backstage view will appear.

B H - 3 -

m HOME IMSERT DESIGM
aley VY

D Calibri (Body) =11 ~| A A
ER

Paste\r B I U -abex, X M-

-

Clipboard ra Font




Account

Options

nfo

»

Protect
Document -

@

Check for
lssues -~

Q

Manage
Verzions ~

Protect Document

Control what types of changes people can make to this document.

Inspect Document

Before publishing this file, be aware that it contains:
Document properties and author's name

Versions

] There are no previous versions of this file,

Properties -
Size

Pages

Words

Total Editing Time
Title

Tags

Comments

Related Dates
Last Modified
Created

Last Printed

Related People
Author

Last Modified By

Show All Properties

Mot saved yet
1

0

0 Minutes
Add a title
Add a tag

Add comments

Today, 12:19 PM

H Fatrice Ball

Add an author

Mot saved yet




OPTIONS

Make Word Your Own
Customize

Word Options
_ r.t_:,.. General options for working with Word.
Display .
Proofing User Interface options
Save [J Show Mini Toolbar on selection
Language @ Enable LNC Preview ' i)
Bl £ Update document content while dragging

Customize Ribbon
Quick Access Toolbar
Add-Ins

Trust Center

ScreenTip style:  Show feature descriptions in ScreenTips

Personalize your copy of Microsoft Office

User name: Patrice Ball

Initials: PB
[] Always use these values regardless of sign in to Office.
Office Background: ‘No Background

Office Theme: :Whiite .

Start up options

Choose the extensions you want Word to open by default:

4] Tell me if Microsoft Word isn't the default program for viewing and editing documents.

Default Programs...

(4] Open e-mail attachments and other uneditable files in reading view

[ Show the Start screen when this application starts




PRACTIGE

* Tables * Screenshots/Screen Clippings
* Pictures * WordArt
* Shapes * Headers, footers, page numbers, text |
« SmartArt boxes |
» Shapes * Quick parts

* Other

Charts




